
Libre office



What is Libre office

LibreOffice is an office suite that allows you to create documents such as letters, 

posters, cards, presentations, slideshows, lists, budgets, charts, and much more. 

LibreOffice is open source, which means that all of the underlying code that makes 

the program work is available to anyone who wants to expand on or modify it. It is the 

superior successor to another popular office suite Open Office. Many people use 

LibreOffice as a free alternative to programs such as Microsoft Office or iWork. It is 

particularly helpful as it can open file types from several different other office suites, 

including Microsoft Office, WordPerfect, and Microsoft Works. LibreOffice is also a 

good option for those who only have very simplistic office applications on their 

computer (e.g. Microsoft Works, WordPad) or those who are attracted by LibreOffice's 

open source ethos. The application suite is available for all platforms of computers, 

including Windows, Mac OS, and Linux. Term: An office suite is a set of program that 

allows you to create documents on your computer, including letters, forms, financial 

documents, charts and graphs, databases, presentations, slideshows, posters, and 

cards. A typical office suite will include applications for word processing, 

spreadsheets, presentations, and design.



•It's free (as in speech) which means you can change it and rebuild it should you desire.

•It's free (as in beer)

•It's cross-platform in that it's written in Java, so it'll run on pretty much any platform

•Since it and its file formats are open you will still have access to the source in years to 

come and won't be stuck with not being able to open old legacy documents, like MS Office 

et al have demonstrated in the past

•It defaults to using open standards, rather than Microsoft's "open" standards which aren't 

really that open

•It'll save PDFs without hassle

•You can download it to your computer without having to give up any personal information

•It's not a gazillion gigabytes to download

•You can install it on as many machines as you like
•You can give a copy to your friends

Advantage of libre office 



Disadvantage of libre office 

•It doesn't do a lot of the more obscure things you can do in MS Office (if you don't 

know what they are, it's not surprising, most users are unlikely to notice)

•It doesn't come with technical support as part of whatever package you buy

•It doesn't 100% handle MS' proprietary formats, or indeed their fake "open" 

formats (which can contain binary information which isn't in the spec)

•The table handling in the word processor is worse than the one in MS Word, 

although since that's pretty awful anyway I don't see this as a problem. If you're 

using funky tables in your document, you probably shouldn't be using a word 

processor in the first place

•It's a bit slower, and uses up a lot of memory, because Java.
•change tracking in MS Office is more advanced.



The LibreOffice Suite LibreOffice provides several different programs, with different functions for each. Below we 
list the programs available and what they do. 

Writer
Writer is a general-purpose word processing program (similar to Microsoft 
Word). It can be used to create letters, reports, lists, and other text-heavy 
documents. You can adorn these documents with tables and pictures. 
Documents can be printed, if desired. This walkthrough was made using 
Writer

Calc
Calc can be used to create spreadsheets (similar to Microsoft 
Excel ) tabular documents that can be used for budgeting, 
inventory, databases of addresses, forms, and more. Formulas 
can be used to dynamically calculate figures. You can also 
generate colorful charts and graphs

Impress
This program is your go-to place for presentations (similar to 
Microsoft PowerPoint), such as if you're asked to present on a 
topic to a public group or would like to display a slideshow. You can 
insert text, pictures, charts, and tables. Slides and information can 
also be animated in various ways for emphasis



.draw
Used for more free-form documents (similar to Microsoft Publisher), Draw is a 
great way to make posters, cards, and other documents that require a bit of 
creativity. It makes it particularly easy to insert pictures, change the 
appearance of text, and create customized shapes.

Base
Base is a powerful database program (similar to Microsoft Access) that allows you 
to enter large amounts of data and generate custom forms and reports from that 
data. It's best used to large projects, such as tracking store inventories. Base 
probably has little application for a home user.

Math
This specialized program is used to create the text of mathematical formulas. 
Such formulas often use particular characters and formatting. Math can be 
used to create visual representations of formulas that would be difficult to do 
with other applications.



You can open LibreOffice in a couple of different ways. First, you can 

double-click the icon that was created on your desktop during the 

install process. A screen similar to the one at right will open. From 

here, you can choose what type of document you'd like to open, and 

LibreOffice will open the correct application. You can also open all of 

the LibreOffice applications from the main menu of your computer (the 

Start Menu then “All 

Writer can be used to create a number of different types of documents tat 

primarily focus on text. For instance, at left is a letter that includes a letterhead 

image. In addition to simply being able to type text, Writer can also do more 

complex things such as allow you to insert images (such as the letterhead 

image in the example), tables, charts, bulleted lists, and much more.



Clicking “Text Document” will open Writer, the word processing program. The Writer opening
screen is explained below. 

Rulers: 
Lets you know and adjust 
your margins and your 
position on the document. 
Documents default to 8.5 X 

” size and 0.79” margins. 11 

Menus: 
Click the menus to access many additional 
functions of Writer, such as alternate views, 
inserting objects into your documents, adjusting 
font and document properties, and more. 

Standard toolbar: 
The top toolbar gives 
access to basic document 
functions: saving, opening, 
printing, creating PDFs, etc. 

Formatting toolbar:
The bottom toolbar lets you 
adjust text: the font, font size, 
alignment, bulleting, and more.

Zoom: 
Use this slider to adjust how large the 
document looks on the screen. This does not
affect the size of the document when it prints. 

Content area: 
This is where the 
information you enter 
will be displayed. 

Programs” in Windows, the Applications menu on Macs, or the applications or main menu of Linux-based operating systems).





Because of Writer's versatility, it can be used to create fairly complicated documents such as reports, detailed 

walkthroughs such as the one at right or the one you're reading right now! Thanks to the “Save as PDF” function, 

easily available on the toolbar, you can also send the documents to others and ensure that they can open it no matter 

what operating system or office suite they use.

Menus and toolbars
Many of the functions and tools available in LibreOffice are accessed through the menus and toolbars. Each program 

in LibreOffice uses slightly different menus and toolbars, but they also share many common features. You can use 

your mouse to navigate these menus by leftclicking the appropriate word or icon.

The menu bar (shown below) is used to access all of the functions available in a program. By left-clicking the words at the top of the 

screen, you have the option to select various tools and make changes. For instance, clicking the “Insert” menu in Writer allows you to 

insert headers & footers, images, tables, and more. Left-clicking on one of the options under a menu will often open a small window 

that lets you adjust options. For instance, if you open the “Insert” menu, then click “Table,” a window will appear that asks you how 

many columns and rows you'd like to have in your table.

Toolbars are icons that allow you even quicker access to LibreOffice's tools. Moving your mouse cursor over an icon opens a small 

hovering explanation of what that icon will do if you click it.

The standard toolbar, shown below, is common across all LibreOffice applications. It allows you to perform basic functions with the 

document: saving, printing, checking spelling, searching for text etc.



File functions:
Saving, creating, or opening 
existing documents, etc.

Printing:
Print, print preview, 
or save as PDF.

Undo and redo: 
Fix mistakes you 
may have made. 

Document tools: 
Change the zoom, 
search for text, etc. 

Font design and size

Bold, italics, and underlining

Alignment (e.g. centering)

Bullets and numbering 

Color and highlighting 

Toolbars are icons that allow you even quicker access to LibreOffice's tools. Moving your mouse cursor over an icon opens a small 

hovering explanation of what that icon will do if you click it.

The standard toolbar, shown below, is common across all LibreOffice applications. It allows you to perform basic functions with the 

document: saving, printing, checking spelling, searching for text etc.

Another common toolbar is the formatting toolbar. It is used to change the appearance of text by 

making it bold, underlined, changing its size and design, and more. To change text, click and hold your 

left mouse button and drag your cursor over some text to highlight it. You can then select options from 

the formatting toolbar (such as clicking the “bold” icon) to change the appearance of the text.

There are different toolbars in the different applications depending on what you are doing. You can view or add more toolbars to your 

screen by clicking the “View” menu, moving your cursor over “Toolbars,” and then left-clicking the toolbar you want to open. Many 

toolbars will open automatically when you use certain tools. For instance, when you insert a table in Writer, the “Table” toolbar will 

open automatically.



Ctrl+A Select All

Ctrl+J Justify

Ctrl+D Double Underline

Ctrl+E Centered

Ctrl+H Find and Replace

Ctrl+Shift+P Superscript

Ctrl+L Align Left

Ctrl+R Align Right

Ctrl+Shift+B Subscript

Ctrl+Y Redo last action

Ctrl+0 Apply Text Body paragraph style

Ctrl+1 Apply Heading 1 paragraph style

Ctrl+2 Apply Heading 2 paragraph style

Ctrl+3 Apply Heading 3 paragraph style

Ctrl+4 Apply Heading 4 paragraph style

Ctrl+5 Apply Heading 5 paragraph style

Ctrl+plus
Calculates the selected text and copies the result to 
the clipboard.

Ctrl+Shift+- Non-breaking hyphen (is not used for hyphenation)

Ctrl+* (only on number 
pad)

Run macro field

Ctrl+Shift+Space
Non-breaking spaces. Non-breaking spaces are not 
used for hyphenation and are not expanded if the 
text is justified.

Shift+Enter Line break without paragraph change

Ctrl+Enter Manual page break

Ctrl+Shift+Enter Column break in multicolumnar texts

Alt+Enter
Inserting a new paragraph without numbering 
inside a list. Does not work when the cursor is at 
the end of the list.

Alt+Enter
Inserting a new paragraph directly before or after a 
section, or before a table.

Arrow Left Move cursor to left

Shift+Arrow Left Move cursor with selection to the left

Ctrl+Arrow Left Go to beginning of word

Ctrl+Shift+Arrow Left Selecting to the left word by word

Arrow Right Move cursor to right

Shift+Arrow Right Move cursor with selection to the right

Ctrl+Arrow Right Go to start of next word

Ctrl+Shift+Arrow Right Selecting to the right word by word

Arrow Up Move cursor up one line

Shift+Arrow Up Selecting lines in an upwards direction

Ctrl+Arrow Up Move cursor to beginning of the previous paragraph

Ctrl+Shift+Arrow Up
Select to beginning of paragraph. Next keystroke 
extends selection to beginning of previous 
paragraph

Arrow Down Move cursor down one line

Shift+Arrow Down Selecting lines in a downward direction

Ctrl+Arrow Down Move cursor to beginning of next paragraph.

Ctrl+Shift+Arrow Down
Select to end of paragraph. Next keystroke extends 
selection to end of next paragraph

Home Go to beginning of line

Write General shortcut key



Home+Shift Go and select to the beginning of a line

End Go to end of line

End+Shift Go and select to end of line

Ctrl+Home Go to start of document

Ctrl+Home+Shift Go and select text to start of document

Ctrl+End Go to end of document

Ctrl+End+Shift Go and select text to end of document

Ctrl+PageUp Switch cursor between text and header

Ctrl+PageDown Switch cursor between text and footer

Insert Insert mode on/off

PageUp Screen page up

Shift+PageUp Move up screen page with selection

PageDown Move down screen page

Shift+PageDown Move down screen page with selection

Ctrl+Delete Delete text to end of word

Ctrl+Backspace Delete text to beginning of word In a list

Ctrl+Delete+Shift Delete text to end of sentence

Ctrl+Shift+Backspace Delete text to beginning of sentence

Ctrl+Tab Next suggestion with Automatic Word Completion

Ctrl+Shift+Tab Use previous suggestion with Automatic Word Completion

Ctrl+Alt+Shift+V Paste the contents of the clipboard as unformatted text.

Ctrl+Shift+F10
Use this combination to quickly dock or undock the Navigator, Styles and Formatting window, 
or other windows

Write General shortcut key



F2 Formula Bar

Ctrl+F2 Insert Fields

F3 Complete AutoText

Ctrl+F3 Edit AutoText

F4 Open Data Source View

Shift+F4 Select next frame

F5 Navigator on/off

Ctrl+Shift+F5 Navigator on, go to page number

F7 Spellcheck

Ctrl+F7 Thesaurus

F8 Extension mode

Ctrl+F8 Field shadings on / off

Shift+F8 Additional selection mode

Ctrl+Shift+F8 Block selection mode

F9 Update fields

Ctrl+F9 Show fields

Shift+F9 Calculate Table

Ctrl+Shift+F9 Update Input Fields and Input Lists

Ctrl+F10 Nonprinting Characters on/off

F11 Styles and Formatting window on/off

Shift+F11 Create Style

Ctrl+F11 Sets focus to Apply Style box

Ctrl+Shift+F11 Update Style

F12 Numbering on

Ctrl+F12 Insert or edit Table

Shift+F12 Bullets on

Ctrl+Shift+F12 Numbering / Bulle

Write function shortcut key



Ctrl+A
If the active cell is empty: selects the whole table. Otherwise: selects the contents of the 
active cell. Pressing again selects the entire table.

Ctrl+Home
If the active cell is empty: goes to the beginning of the table. Otherwise: first press goes to 
beginning of the active cell, second press goes to beginning of the current table, third press 
goes to beginning of document.

Ctrl+End
If the active cell is empty: goes to the end of the table. Otherwise: first press goes to the end 
of the active cell, second press goes to the end of the current table, third press goes to the end 
of the document.

Ctrl+Tab
Inserts a tab stop (only in tables). Depending on the Window Manager in use, Alt+Tab may be 
used instead.

Alt+Arrow Keys Increases/decreases the size of the column/row on the right/bottom cell edge

Alt+Shift+Arrow Keys Increase/decrease the size of the column/row on the left/top cell edge

Alt+Ctrl+Arrow Keys Like Alt, but only the active cell is modified

Ctrl+Alt+Shift+Arrow Keys Like Alt, but only the active cell is modified

Alt+Insert 3 seconds in Insert mode, Arrow Key inserts row/column, Ctrl+Arrow Key inserts cell

Alt+Delete
3 seconds in Delete mode, Arrow key deletes row/column, Ctrl+Arrow key merges cell with 
neighboring cell

Writer table shortcut key



Esc
Cursor is inside a text frame and no text is selected: Escape selects the text 
frame.

F2
If a text frame is selected: positions the cursor to the end of the text in the 
text frame. If you press any key that produces a character on screen, and the 
document is in edit mode, the character is appended to the text.

Alt+Arrow Keys Move object.

Alt+Ctrl+Arrow Keys Resizes by moving lower right corner.

Alt+Ctrl+Shift+Arrow Keys Resizes by moving top left corner.

Ctrl+Tab Selects the anchor of an object (in Edit Points mode).

Paragraphs and Heading Levels shortcut key
Ctrl+Alt+Arrow Up Move the active paragraph or selected paragraphs up one paragraph.

Ctrl+Alt+Arrow Down Move the active paragraph or selected paragraphs down one paragraph.

Tab
The heading in format "Heading X" (X = 1-9) is moved down one level in the 
outline.

Shift+Tab

Moving resizing frame and graphics shortcut key

Writer shortcut key



Calc
Speaking of tables, LibreOffice includes an application that is specifically devoted to tabular 

information, whether textual or numerical: Calc. Calc is a spreadsheet program. Its documents are 
laid out in columns and rows, and the information can be manipulated to create charts and 

calculate figures. The Calc screen is explained below.

Content area:

I nformation in Calc is 

divided into cells in 

rows and columns. 

Formula bar: 

Shows you the detailed 

content of a cell, including any 

functions that are performing 

calculations in your document. 

Standard and formatting toolbars 

Sheets: 

Calc allows you to create separate 

“sheets” to store information so that 

you can organize information easily. 



calculate how often each person appears in the schedule. 

Calc can be used for more 

than numerical purposes, 

though. It can also be used 

for lists, databases of 

address, schedules, and 

much more. At right is an 

example of a schedule made 

using Calc. The application's 

simple grid design makes it 

easy to layout a schedule. 

Separate sheets are used for 

each month, allowing for 

easy organization of the 

schedules. You can also 

format cells in various ways 

by adding gridlines, 

background colors, and 

more. Functions can be used 

to identify text as well as 

perform numerical 

operations. in the example 

on the left, functions are 

used to 



Calc excels at dealing with 

numbers. It can be used to 

create budgets, calculate 

statistics, and present data in 

easy-to-understand tabular 

format. Data can also be 

presented in charts, such as 

bar, line, or pie. At right is an 

example of a budget that was 

created using Calc. It makes 

liberal use of functions, which 

allow Calc to compute figures 

dynamically. Thus, if you 

change the contents of a cell, 

the function will autmatically

update the calculation. 

Functions can do everything 

from adding up lists of numbers 

to counting occurrences of 

certain words or phrases to 

extremely complex statistical 

calculations. While it is beyond 

the scope of this walkthrough to 

discuss functions in detail, they 

are definitely one of the most 

powerful aspects of Calc. 



Ctrl+Home Moves the cursor to the first cell in the sheet (A1).

Ctrl+End Moves the cursor to the last cell on the sheet that contains data.

Home Moves the cursor to the first cell of the current row.

End Moves the cursor to the last cell of the current row in a column containing data.

Ctrl+Left Arrow Moves the cursor to the left edge of the current data range. If the column to the left of the cell 
that contains the cursor is empty

Ctrl+Right Arrow Moves the cursor to the right edge of the current data range. If the column to the right of the cell 
that contains the cursor is empty

Ctrl+Up Arrow Moves the cursor to the top edge of the current data range. If the row above the cell that 
contains the cursor is empty

Ctrl+Down Arrow Moves the cursor to the bottom edge of the current data range. If the row below the cell that 
contains the cursor is empty

Ctrl+Shft+Arrow Selects all cells containing data from the current cell to the end of the continuous range of data 
cells

Ctrl+ Page Up Moves one sheet to the left. In the page preview it moves to the previous print page.

Ctrl+Page Down Moves one sheet to the right. In the page preview it moves to the next print page.

Page Up Moves the viewable rows up one screen.

Page Down Moves the viewable rows down one screen.

Alt+Page Up Moves the viewable columns one screen to the left.

Alt+Page Down Moves the viewable columns one screen to the right.

Shft+Ctrl+Page Up Adds the previous sheet to the current selection of sheets. If all the sheets in a spreadsheet are 
selected

Shft+Ctrl+Page Down Adds the next sheet to the current selection of sheets. If all the sheets in a spreadsheet are 
selected

Ctrl+* Selects the data range that contains the cursor. A range is a contiguous cell range that contains 
data and is bounded by empty row and columns. The * key is the multiplication sign on the 
numeric key pad.

Ctrl+/ Selects the matrix formula range that contains the cursor. The / key is the division sign on the 
numeric key pad.

Enter - in a selected range By default

Navigation and selection calc shortcut key



F1 Displays the OOo help browser. When the help browser is already open F1 jumps to the main help 
page.

Shft+F1 Displays context help.

Ctrl+F1 Displays the note that is attached to the current cell.

F2 Switches to Edit mode and places the cursor at the end of the contents of the current cell. If the 
cursor is in an input box in a dialog that has a minimize button

Ctrl+F2 Opens the Function Wizard.

Shft+Ctrl+F2 Moves the cursor to the input line where you can enter a formula for the current cell.

Ctrl+F3 Opens the Define Names dialog.

F4 Shows or hides the Database Sources menu.

Shft+F4 Rearranges the relative or absolute references (for example

F5 Shows or hides the Navigator.

Shft+F5 Traces dependents.

Shft+Ctrl+F5 Moves the cursor to the Name box.

F7 Checks spelling in the current sheet.

Ctrl+F7 Opens the Thesaurus if the current cell contains text.

Shft+F7 Traces precedents.

F8 Turns additional selection mode on or off. In this mode

Ctrl+F8 Highlights cells containing numeric values (not text).

F9 Recalculates all of the formulas in the sheet.

Ctrl+F9 Updates the selected chart.

F11 Opens the Styles and Formatting window where you can apply a formatting style to the contents 
of the cell or to the current sheet.

Shft+F11 Creates a document template.

Shft+Ctrl+F11 Updates the templates.

F12 Groups the selected data range.

Ctrl+F12 Ungroups the selected data range.

Alt+Down Arrow Increases the height of current row.

Alt+Up Arrow Decreases the height of current row.

Alt+Right Arrow Increases the width of the current column.

Alt+Left Arrow Decreases the width of the current column.

Calc function shortcut key



Impress

Sometimes, you may find yourself needing to give a public 

presentation, or maybe even a slideshow of photos for your family. 

Enter Impress. It is used to create presentations with slides. You can 

insert text, photos, clipart, videos, tables, charts, and much more into 

Impress slides. Slides typically include a title and then elements such 

as boxes for text or photos. You can animate various parts of the 

slide, as well as insert special effects when you move to a new slide.

When you first open Impress, it will open a dialog window that asks 

what you'd like to do. You can open an empty presentation (simply 

white background with black text - a blank canvas!), open a 

presentation you've already made, or start a new presentation from a 

template. Templates are visual themes for a presentation. They'll 

typically change the background, font and color, and placement of 

various elements in the presentation. Use templates to make your 

presentation prettier!

If you choose to make your presentation from a template, you'll be given various options for slide designs. For 

instance, at right we've selected a theme called “Glacier: that puts a glacier image in the background and gives the 

text a black and white theme. You can also choose whether you intend to make the presentation directly from a 

computer, print it out on paper, or other options.





Impress also allows you to animate 

objects in your slides as well as the 

transitions between slides. If you 

open a presentation with the 

template, you can set a default 

animation between slides. If you're 

doing a slideshow, you can also set 

the presentation to automatically 

advance each slide without you 

having to do anything. While the 

animations and transitions in 

Impress are fun, however, they 

should be used judiciously, 

especially in public presentations.

At right is an example of a 

customdesigned Impress 

presentation. You can use 

templates to design your 

presentations, as already 

explained, or you can design your 

own. In the example, the 

background has been changed as 

has the overall placement of text 

and images on the slides. Don't feel 

limited by the templates! You can 

even make presentations that have 

designs custom-made to fit your 

business or organization's logo and 

theme.

The Impress screen is explained a 

bit more below.



Slide preview: 

Allows you to preview 

and navigate among 

the slides in your 

presentation.

Views: 

View and edit your slides, 

notes, and handouts. 

Tasks bar: 

This is where you change 

factors like slide design, 

layout, animations, 

transitions, and more. 

Content area:

Change your slides by 

inserting text, images, 

tables, and other elements.



F1 Displays the OOo help browser. When the help browser is already open F1 jumps to the main help 
page.

Shft+F1 Displays context help.

Ctrl+F1 Displays the note that is attached to the current cell.

F2 Switches to Edit mode and places the cursor at the end of the contents of the current cell. If the 
cursor is in an input box in a dialog that has a minimize button

Ctrl+F2 Opens the Function Wizard.

Shft+Ctrl+F2 Moves the cursor to the input line where you can enter a formula for the current cell.

Ctrl+F3 Opens the Define Names dialog.

F4 Shows or hides the Database Sources menu.

Shft+F4 Rearranges the relative or absolute references (for example

F5 Shows or hides the Navigator.

Shft+F5 Traces dependents.

Shft+Ctrl+F5 Moves the cursor to the Name box.

F7 Checks spelling in the current sheet.

Ctrl+F7 Opens the Thesaurus if the current cell contains text.

Shft+F7 Traces precedents.

F8 Turns additional selection mode on or off. In this mode

Ctrl+F8 Highlights cells containing numeric values (not text).

F9 Recalculates all of the formulas in the sheet.

Ctrl+F9 Updates the selected chart.

F11 Opens the Styles and Formatting window where you can apply a formatting style to the contents of 
the cell or to the current sheet.

Shft+F11 Creates a document template.

Shft+Ctrl+F11 Updates the templates.

F12 Groups the selected data range.

Ctrl+F12 Ungroups the selected data range.

Alt+Down Arrow Increases the height of current row.

Alt+Up Arrow Decreases the height of current row.

Alt+Right Arrow Increases the width of the current column.

Alt+Left Arrow Decreases the width of the current column.

Alt+Shft+Arrow Key Optimizes the column width or row height based on the current cell.

Impress shortcut key



Draw

Sometimes you may need 

to create more freeform 

documents, ones that aren't 

as restricted by margins, 

grids, or boxes. Enter Draw. 

It can be used to create 

flyers, cards, banners, 

maps, and many other 

documents that put your 

creativity to work.z

Draw makes it easy to insert 

pictures and text boxes and 

even to design your own 

shapes and other elements 

for your flyer. At left is a flyer 

made in Draw that includes 

many photos, images, text 

of various sizes and colors, 

and a background. Items 

can be easily moved around 

the screen and can be 

placed in layers over or 

under each other. This 

makes designed freeform 

documents very simple.

The Draw screen is 

explained in more detail 

below.



Content area: 

Change your slides by 

inserting text, images, 

tables, and other elements. 

Line and filling toolbar: 

Add borders and fill to 

objects that you've put into 

your document. 

Pages:

Shows the different parts 

of your document, such 

as if you're making a 

multi-page card. 

Drawing toolbar: 

Allows you to create 

shapes, text boxes, special 

text art, and many more 

features to your documents. 





F1 Displays the OOo help browser. When the help browser is already open F1 jumps to the main help page.

Shft+F1 Displays context help.

Ctrl+F1 Displays the note that is attached to the current cell.

F2 Switches to Edit mode and places the cursor at the end of the contents of the current cell. If the cursor is in an input 
box in a dialog that has a minimize button

Ctrl+F2 Opens the Function Wizard.

Shft+Ctrl+F2 Moves the cursor to the input line where you can enter a formula for the current cell.

Ctrl+F3 Opens the Define Names dialog.

F4 Shows or hides the Database Sources menu.

Shft+F4 Rearranges the relative or absolute references (for example

F5 Shows or hides the Navigator.

Shft+F5 Traces dependents.

Shft+Ctrl+F5 Moves the cursor to the Name box.

F7 Checks spelling in the current sheet.

Ctrl+F7 Opens the Thesaurus if the current cell contains text.

Shft+F7 Traces precedents.

F8 Turns additional selection mode on or off. In this mode

Ctrl+F8 Highlights cells containing numeric values (not text).

F9 Recalculates all of the formulas in the sheet.

Ctrl+F9 Updates the selected chart.

F11 Opens the Styles and Formatting window where you can apply a formatting style to the contents of the cell or to the 
current sheet.

Shft+F11 Creates a document template.

Shft+Ctrl+F11 Updates the templates.

F12 Groups the selected data range.

Ctrl+F12 Ungroups the selected data range.

Alt+Down Arrow Increases the height of current row.

Alt+Up Arrow Decreases the height of current row.

Alt+Right Arrow Increases the width of the current column.

Alt+Left Arrow Decreases the width of the current column.

Alt+Shft+Arrow Key Optimizes the column width or row height based on the current cell.

Draw keyboard shortcut key


